Merging Duplicate Individuals using PAF Insight

Begin by opening your PAF database or backup (.zip) into PAF Insight either from the
Tools menu in PAF or directly into PAF Insight.

Choose "Merge" from the "Choose a Mode" window.
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If you already have your PAF ﬁ o in PAF Ins1ght go he Mode menu on the Menu
bar and choose "Merge"
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Your database will open in Merge.

The Individual List opens in Normal view. There are four choices you can choose to
view.
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Normal --- Shows all the individuals that are possible matches. It also shows records that
you have previously marked for Research

e Show all Not a Match---Shows all the records shown in the Normal view plus
records you have previously marked as Not a Match

o Hide Research---Shows only those matches that have not been marked for
research.

o Show Research Only---Gives a list of all those you have marked for research.

The Individual List will show the individuals that are possible candidates to merge. The
Details View of the Individual List is shown when the program opens. Information for
each individual can be viewed in the Details view when they are highlighted in the
Individual list. Any differences are highlighted in pink. When information appears in the

secondari file and the corresponding field in the primary file is empty, the data -
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When the program opens, individuals are listed according to the % match column in
order of their match probability. The % match column is on the far right of the Individual
List.



You can change the list order by clicking on one of the column headings at the top of the
Individual List or by changing the "Sort by" selection using the dropdown list. This will
arrange the records by Status, Primary RIN, Primary Surname or Primary Given Name,
Secondary RIN, Secondary Surname or Secondary Primary Name, or % Match.

Go to Edit on the Menu bar and choose Preferences.
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This will take you to the Preferences window.
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Select Match/Not a Match and choose whether you want your Not A Match notations to
appear in your notes and whether you want a hidden Not a Match Database. If at any time
you want to change where or how you store your “Not a Match” information, you can
make the change here. You can also select your matching preferences for the matching
threshold as well as whether to ignore case when matching.

To MERGE

o Select a pair of individuals to merge. You can move through the Individual List
using the Next and Previous icons, the up and down arrow keys on your
keyboard, Next or Previous in the Actions menu, or by clicking on an individual.

o Compare the information in the fields highlighted in pink.. This highlighting
indicates differences.

« Evaluate the information in the fields highlighted'in green. This highlighting
indicates that there is no information in the corresponding field in the primary file.



You can also compare how they fit in the pedigree by choosing to show the

pedigrees from the View menu. You can move around in a pedigree using the

pedigree Scroll Bar and arrows.
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You may switch the primary record, on the left, with the secondary record, on the
right, by clicking the Switch icon, using the Shortcut keys of Control + W, or
selecting Switch from the Actions menu.
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Make sure that the information you want to merge is checked. If there is
information in the right hand record that is missing in the left hand record, this
information is checked by default. You may uncheck this information if desired
and check other information you would like merged.

When you find the information you would like merged into the primary record,
choose the appropriate information selection type from the list next to the event.
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For Individual life events you can choose from

o Merge--this will merge any checked information with the information that
is in the primary record. You must check the information you want
brought over.

o Add as #1 (or other number) -- This will add the information on the right
as the primary data for this event. Any information you had for the event
will move to "Other Events" on your Edit Individual screen in PAF.

o Add as New -- Will add the information as new information under "Other
Events" in PAF.

o Ignore -- Choose this if you do not want to update any information for this
event.

For Marriage events you first choose how you wish to transfer the data on the
right into your records on the left. From the drop down box on the first line of the
marriage information section, choose from the following:

MARRIAGES MARRIAGES
Maniage RIN 829 Not Divorced v Maniage RIN 856 Not Divorced Match yifh: Mariage RIN 829
= = . Marriage RIN 829 k
| Spouse (RIN 2578) Susan /Potter/ # Spouse (RIN 2578) Susan /Potter/ Add
Marr At 1883 |of. . Rhode Island, USA d Mar [ |Jun 1883 [] [Kent. Kent. Rhode Islat, L lanore
Slg Sp. | rd Slg Sp. |
No Children Show Children  No Children Show Children

o Add as Marriage RIN#--If the information in the right is the same or
very similar to the information on the left, you may get this option. This
merges the information on the right with the same MRIN # on the left
when you Merge your records.

o Add -- This adds the marriage as a new marriage for the individual when
you Merge your records.

o Ignore -- If you choose this option, no marriage information will be added
to your file when you Merge your records.

Next, you need to decide how you want to transfer the actual marriage event data
on the right with the event data on the left. You may have the same marriage date
in both the primary and secondary files but the places may be different. By
clicking on the drop down box to the right of the date and place fields, you can
choose from the following options:

MARRIAGES MARRIAGES

Maniage RIN 829 |Not Divorced + Mamiage RIN 856 Not Divorced Match with: Mamiage RIN 829 v
Spouse (RIN 2578) Susan /Poiter/ |# Spouse (RIN 2578) Susan /Potter/
Marr At 1883 of. . Rhode Island, USA i Mam.[] [Jun 1883 [ |Kent. Kent. Rhode Island. USA
Slg.Sp. I Sig Sp. ]
No Children Show Children | No Children

o Merge - This will merge any checked information from the right side with
the information you have in your record on the left. You must check the
information you want brought over into your primary record.



Add as #1 (or other number) - This will add the information on the right
as the primary data for this event. Any information you had for the event
will move to "Other Events" for the marriage.

o Add as New - This keeps your original information as the primary
information and adds the new information under "Other Events" in your
file for this marriage.

o Ignore - Choose this if you do not want to update any information for this

marriage.

o

For Parent information choose how and if you want information merged in your

file.
'PARENTS PARENTS
Parenits Mamiage RIN 824 Parcnts Marriage RIN 824
[Father - RIN 2561 |Asa /stone/ |Mother - RIN 2562 [Phebe /Greens Father - RIN 2561 Asa /Stone/
Relationship to parenis: Biclogical ~| Relationship to parents: Biological =
Slg Par.| Fd Sig Par. 12 Nov 1993
11 Children 11 Crildren

o Merge with Parents Marriage RIN # -- this will merge the family
information from the right side individual with the family information of
the individual on the left for the corresponding family number.

o Add -- When the records are merged, the checked parents on the right will
be added as a new set of parents for the individual on the left.

o Ignore -- Choose this if you do not want to add or update any information

for parents.

When you have selected the information you want updated, you can merge that
information into your file by clicking on the Merge icon or choosing Merge from
the Action menu or using the shortcut key Control+M.
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The information that you have merged can now be seen in the left hand record in
the details view. If there are any changes you would like to make you can edit the
information in your record while in PAF Insight.

Sources and Notes

When you update information from the secondary record into an individual in
your primary record, sources are added to the event(s) that were merged
according to the preferences you have selected. Other sources are also added if
you checked "Add when Updating" in the source citation window. You can view



and edit a source by clicking on the source icon, next to the event, in the Primary

record.
/]

e When sources contain differences, the source icon will be highlighted in pink.

Source Icon showing differences

o If'there are differences in the notes, the Show Notes button will be highlighted in
pink and the Notes Selection Box will become active. You can view the text of
the notes by clicking on the Show Notes button and the differences in text will be
highlighted in pink.

RELATIONSHIP: Listed as parents in marmiage transcrip of child (see MC-0029-015)

Details
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#s ﬂ Primary Individual - RIN 1322 | 7] 99% Match Duplicate Individual - RIN 1676 &)
Anne Barbara (Bait Shrs Female v|[] |Anna Barbara /Fohr/ [ |Female
e - - =
12 Children Show Children
Show Notes|
PARENTS PARENTS
Parents Mariage RIN 495 Parents Marriage RIN 435 Maich with: Parents Marriage RIN 435 v
Father - RIN 1325 Dominique /Forr/ Mother - RIN 1326 Antoinette or Antonia /Dor  Father - RIN 1325 Dominique /Forr/ Mother - RIN 1326 Antoinette or Antonia /Dor
Relationship to parents: Biological | Relationship to parents- Biological
S5ig_Par.28 Sep 2004 SLAKE A Sig.Par.[] |08 Mar 2005 SLAKE Fa
6 Children Show Children| 6 Children Show Children

INDIVIDUAL NOTES

records for girls by the same name. See DOC-0033-013 &
date on the second record is also the 19th. | think that it's unlikely

From the Notes Selection Box you can choose to:

o Replace — The notes on the left will be replaced with the notes on the right
when merging.

o Combine — This will combine the notes from both records. If there are
common notes in both records they will not be duplicated; only the
differences highlighted in pink will be combined.

o Ignore — This will ignore the notes on the right and not change anything in
the notes on the left.

You may also choose to edit the notes on the left directly in the notes field.
If there are only notes on one side, those notes will be kept by default. If
there are notes on both sides, then Combine will be selected. If there are
common notes in both records only the differences highlighted in pink will
be added from the right to the left record.
o The modified notes will not be permanent until you save your database. When
you have modified your file, "Modified" will be shown in the lower right corner.

e When the information that you desire is selected, click on the Merge icon or
Control+M, or select Merge from the Actions menu. This will merge the




information in the secondary record, on the right, into the primary record, on the
left.

o This information is not saved in your database until you either click on Save, go
to File, on the menu bar, and choose Save or Save As, or click "Yes" from the
popup window when exiting.

Not A Match and Research

o If'there are records that you are sure are not a match you can add a notation to
them by clicking on the Not a Match icon or selecting Not a Match from the
Actions menu.
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o If you have set your preferences to "Put Not A Match in Notes", a note similar to
"NOT-A-MATCH: This individual is not the same as Hans /Hansen/ 1791-?,
PAF ID {aa95eb56-37¢9-11d5-9b14-0050baad6715}" will be added to your
PAF record under Notes.

o If you have set your preferences to "Save Not A Match info in a database", it will
be stored there.

o With a notation in either the notes or in the Not a Match database, they will not be
matched by PAF Insight again. Only using the Not A Match database will render
it of no affect if you look at the same records on a different computer.

o If there are records that you would like to research further, you can add a research
note by clicking on the Research icon or selecting Research from the Actions
menu. A note similar to “RESEARCH-FOR-MERGE: This individual might be
the same as Hans /Hansen/, RIN 2178.” will be added to your records.
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o Individuals that have a note added for Research, or have been marked as Not A
Match or Merged, will be listed as such in the status column.
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e When you are finished merging, you need to save your database to finalize the
changes. You can either Save to the original file or Save As to a new file name.
To do this go to the File menu and choose Save or Save As. If you choose Save
As, the Save As Window will appear and you can name your file and Save.

o If you forget and try to exit without saving, you will get a warning. You can then
choose "Yes" to save to your original file name, No to exit without saving the
changes, or Cancel and choose Save As from the File Menu.
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